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The Spreadsheet Link™ EX software Add-In integrates the Microsoft® Excel®
and MATLAB® products in a computing environment running Microsoft®
Windows®. It connects the Excel® interface to the MATLAB workspace,
enabling you to use Excel worksheet and macro programming tools to leverage
the numerical, computational, and graphical power of MATLAB.

You can use Spreadsheet Link EX functions in an Excel worksheet or macro
to exchange and synchronize data between Excel and MATLAB, without
leaving the Excel environment. With a small number of functions to manage
the link and manipulate data, the Spreadsheet Link EX software is powerful
in its simplicity.

Note This documentation uses the terms worksheet and spreadsheet
interchangeably.

The Spreadsheet Link EX software supports MATLAB two-dimensional
numeric arrays, one-dimensional character arrays (strings), and
two-dimensional cell arrays. It does not work with MATLAB
multidimensional arrays and structures.

Microsoft Excel MATLAB
Excel workspace < P  MATLAB workspace
Spreadsheet N |
Link EX
Handle SIMULINK
Graphics
| Macro ‘ ‘ Worksheet‘ MATLAB
Toolboxes Compiler




Installing the Spreadsheet Link™ EX Software

Installing the Spreadsheet Link EX Software

In this section...

“System Requirements” on page 1-3
“Product Installation” on page 1-3

“Files and Directories Created by the Installation” on page 1-3

“Modifying Your System Path” on page 1-4

System Requirements

For information on hardware and software requirements for this product, see
http://www.mathworks.com/products/excellink/requirements.html.

The Spreadsheet Link EX product requires the MATLAB for Microsoft
Windows software. For best results with MATLAB figures and graphics, set
the color palette of your display to a value greater than 256 colors:

1 Click Start > Settings > Control Panel > Display.

2 Click the Settings tab. Choose an appropriate entry from the Color
Palette menu.

Product Installation

Install the Microsoft Excel product before you install the MATLAB and
Spreadsheet Link EX software. To install the Spreadsheet Link EX Add-In,
follow the instructions in the MATLAB installation documentation. Select the
Spreadsheet Link EX check box when choosing components to install.

Files and Directories Created by the Installation

Note Throughout this document the notation matlabroot is the MATLAB
root folder, the folder where the MATLAB software is installed on your system.

The Spreadsheet Link EX installation program creates a subdirectory under
matlabroot\toolbox\. The exlink folder contains the following files:
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® excllink.xla: The Spreadsheet Link EX Add-In

® ExliSamp.xls: Spreadsheet Link EX example files described in this
documentation

The installation also creates a Spreadsheet Link EX initialization file,
exlink.ini, in the appropriate Windows folder (for example, C:\Winnt).

The Spreadsheet Link EX software uses Kernel32.d11, which should
already be in the appropriate Windows system folder (for example,
C:\Winnt\system32). If not, consult your system administrator.

Modifying Your System Path

Add matlabroot\bin to your system path. For more information about
editing your system path, consult your Windows documentation or your
system administrator.
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Configuring the Spreadsheet Link EX Software

In this section...

“Configuring Version 2003 and Earlier Versions of the Microsoft® Excel
Software” on page 1-5

“Configuring Version 2007 of the Microsoft® Excel Software” on page 1-7

“Setting Spreadsheet Link EX Preferences” on page 1-11

Configuring Version 2003 and Earlier Versions of the
Microsoft Excel Software

1 Start Microsoft Excel.
2 Enable the Spreadsheet Link EX Add-In.
a Click Tools > Add-Ins. The Add-Ins dialog box appears.

b Click Browse.

¢ Select matlabroot\toolbox\exlink\excllink.xla.

Note Throughout this document the notation matlabroot is the
MATLAB root folder, the folder where the MATLAB software is installed

on your system.

d Click OK.

In the Add-Ins dialog box, the Spreadsheet Link EX for use with
MATLAB check box 1s now selected.

e Click OK to exit the Add-Ins dialog box.
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The Spreadsheet Link EX Add-In loads now and with each subsequent Excel
session.

The MATLAB Command Window button appears on the Microsoft
Windows taskbar.

i Startl J @ Microsaoft Excel | o\ MATLAE Command Window

The Spreadsheet Link EX toolbar appears on your Excel worksheet.

Start MATLAB
Function Wizard for
Spreadsheet Link EX

Start Execute MATLAB
MATLAB

command

4 icrosoft Excel - Book1

Bl Fle Edt  Wiew Insert |Format  Tools  Datp  Window  Hel
SHRSISQIVE & 2@ F9-

Reply with Chanc

2

A
startmatlab putmatrix getmatrix evalstring getfigure wizard preferences

d % d o a

Send data to Retrieve data
MATLAB from MATLAB

Set MATLAB
Preferences

Import current
MATLAB figure

The Spreadsheet Link EX software is now ready for use.
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Configuring Version 2007 of the Microsoft Excel
Software

1 Start a Microsoft Excel session.

2 Enable the Spreadsheet Link EX Add-In:

(Ba

a Click “ %, the Microsoft Office Button.

b Click Excel Options. The Excel Options dialog box appears.

s @ =

Click Add-Ins.

From the Manage selection list, choose Excel Add-Ins.
Click Go. The Add-Ins dialog box appears.

Click Browse.

Select matlabroot\toolbox\exlink\exc11ink2007.x1lam.
Click Open.

In the Add-Ins dialog box, the Spreadsheet Link EX for use with
MATLAB check box is now selected.
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Add-ins HE

Add-Ins available:

[ Analysis ToolPak ;I oK
[ Analysis ToolPak - VBA
[ Conditional Sum Wizard Cancel
[ Euro Currency Toals
[ Internet Assistant YBA

B
[ Lookup Wizard e
[ Solver Add-n
eadsheet Link EX 3. 1 for use with MATLAB and Excel 2007

LS

Automation...

[

preadsheet Link EX 3.1 for use with MATLAB and Excel 2007
Spreadsheet Link EX 3. 1 for use with MATLAB and Excel 2007

i Click OK to close the Add-Ins dialog box.
k Click OK to close the Excel Options dialog box.

The Spreadsheet Link EX Add-In loads now and with each subsequent Excel
session.
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The MATLAB Command Window button appears on the Microsoft
Windows taskbar:

The MATLAB group appears on the top right of the Home tab in your Excel
worksheet:

™

- B X
W - = x
Sort & Find & .
Filter = Select =

it g Start MATLAB
Send data to MATLAE
Get data from MATLAE

c ||

Run MATLAE command
Get MATLAE figure

MATLAE Function Wizard

Preferences

The Spreadsheet Link EX software is now ready for use.

Right-click on a cell for MATLAB options. The following menu appears:
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Calibi - 11 ~|A° A" $§ -~ % » F

B I = i .0
Ty

53 | Copy

[ Paste

Paste Special...

Insert...

Delete..

Clear Contents

Filter »
Sort »

Insert Comment

g L

Faormat Cells...
Pick From Drop-down List...
Mame a Range..

% Hyperlink...

MATLAE » send data to MATLAE

et data from MATLAE #
Run MATLAE command
Get MATLAE figure

Function Wizard

Note Using both the 2003 and 2007 Add-Ins referenced in Excel 2007 causes
problems with the context sensitive menu. Use only one Add-In at a time to
avoid this issue.
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Setting Spreadsheet Link EX Preferences

Use the Preferences dialog box to set Spreadsheet Link EX preferences.
Click the preferences button in the Excel toolbar or Matlab group to open
this dialog box.

MATLAB Preferences |

www. mathworks.co

¥ ‘Start MATLAB at Excel startup

MATLAE startup folder

c\ |

[ Use MATLAE desktop

[ Show MATLAB errars

r Force use of MATLAE cell arrays with
MLPutMatrix

" Treat missing/empty cells as MaM

Ok Cancel

Preferences include:
e Start MATLAB when Excel starts (enabled by default) starts a
MATLAB session automatically when an Excel session starts.

e MATLAB current working folder lets you specify the current working
folder for your MATLAB session at startup.

e Use MATLAB desktop starts the MATLAB desktop, including the current
folder, workspace, command history, and Command Window panes, when
an Excel session starts.
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* Force use of MATLAB cell arrays with MLPutMatrix enables the
MLPutMatrix function to use cell arrays for data transfer between the Excel
software and the MATLAB workspace.

* Treat missing/empty cells as NaN sets data in missing or empty cells to
NaN or zero.
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Starting and Stopping the Spreadsheet Link EX Software

In this section...

“Automatically Starting the Spreadsheet Link EX Software” on page 1-13
“Manually Starting the Spreadsheet Link EX Software” on page 1-13
“Connecting to an Existing MATLAB Session” on page 1-14

“Stopping the Spreadsheet Link EX Software” on page 1-14

Automatically Starting the Spreadsheet Link EX
Software

When installed and configured according to the instructions in “Configuring
the Spreadsheet Link EX Software” on page 1-5, the Spreadsheet Link EX
and MATLAB software automatically start when you start a Microsoft Excel
session.

Manually Starting the Spreadsheet Link EX Software

To start the Spreadsheet Link EX and MATLAB software manually from the
Excel interface:

1 Click Tools > Macro.
2 Enter matlabinit into the Macro Name/Reference box.

For more information about the matlabinit function, see Chapter 3,
“Function Reference”.

3 Click Run.

The MATLAB Command Window button appears on the Microsoft Windows
taskbar.

1-13



1 Getting Started

1-14

Connecting to an Existing MATLAB Session

To connect a new Excel session to an existing MATLAB session, start
MATLAB with the /automation command-line option. This option starts
MATLAB as an automation server. The Command Window is minimized, and
the Desktop is not running.

1 Right-click your MATLAB shortcut icon.
2 Select Properties.
3 Click the Shortcut tab.

4 Add the string /automation in the Target field. Remember to leave a
space between matlab.exe and /automation.

5 Click OK.

Note This option works only if the current MATLAB session is a registered
automation version. If not, the Excel software starts a new MATLAB session
rather than connecting to the existing one.

Stopping the Spreadsheet Link EX Software

® To stop both the Spreadsheet Link EX and MATLAB software, stop the
Excel session as you normally would.

® To stop the Spreadsheet Link EX and MATLAB software and leave the
Excel session running, enter the =MLClose () command into an Excel
worksheet cell. You can use the MLOpen or matlabinit functions to restart
the Spreadsheet Link EX and MATLAB sessions manually.
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About Functions

In this section...

“How Spreadsheet Link EX Functions Differ from Microsoft® Excel
Functions” on page 1-15

“Types of Spreadsheet Link EX Functions” on page 1-15
“Using Worksheets” on page 1-16
“Working with Arguments in Spreadsheet Link EX Functions” on page 1-18

“Using the MATLAB Function Wizard for the Spreadsheet Link EX
Software” on page 1-20

“Examples: Using Spreadsheet Link EX Functions in Macros” on page 1-23

How Spreadsheet Link EX Functions Differ from
Microsoft Excel Functions

¢ Spreadsheet Link EX functions perform an action, while Microsoft Excel
functions return a value.

® Spreadsheet Link EX function names are not case sensitive; that is,
MLPutMatrix and mlputmatrix are the same.

e MATLAB function names and variable names are case sensitive; that is,
BONDS, Bonds, and bonds are three different MATLAB variables. Standard
MATLAB function names are always lowercase; for example, plot (f).

Note Excel operations and function keys may behave differently with
Spreadsheet Link EX functions.

Types of Spreadsheet Link EX Functions

Spreadsheet Link EX functions manage the connection and data exchange
between the Excel software and the MATLAB workspace, without your
ever needing to leave the Excel environment. You can run functions as
worksheet cell formulas or in macros. The Spreadsheet Link EX software
enables theExcel product to act as an easy-to-use data-storage and
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application-development front end for the MATLAB software, which is a
powerful computational and graphical processor.

There are two types of Spreadsheet Link EX functions: link management
functions and data management functions.

Link management functions initialize, start, and stop the Spreadsheet Link
EX and MATLAB software. You can run any link management function other
than matlabinit as a worksheet cell formula or in macros. You must run
the matlabinit function from the Excel Tools > Macro menu, or in macro
subroutines.

Data management functions copy data between the Excel software and

the MATLAB workspace, and execute MATLAB commands in the Excel
interface. You can run any data management function other than MLPutVar
and MLGetVar as a worksheet cell formula or in macros. The MLPutVar and
MLGetVar functions can run only in macros.

For more information about Spreadsheet Link EX functions, see Chapter 3,
“Function Reference”.

Using Worksheets

Entering Functions into Worksheet Cells

Spreadsheet Link EX functions expect Al-style worksheet cell references;
that is, columns designated with letters and rows with numbers (the default
reference style). If your worksheet shows columns designated with numbers
instead of letters:

1 Click Tools > Options.
2 Click the General tab.

3 Under Settings, clear the R1C1 reference style check box.

Enter Spreadsheet Link EX functions directly into worksheet cells as
worksheet formulas. Begin worksheet formulas with + or = and enclose
function arguments in parentheses. The following example uses MLPutMatrix
to put the data in cell C10 into matrix A:



About Functions

=MLPutMatrix("A", C10)

For more information on specifying arguments in Spreadsheet Link EX
functions, see “Working with Arguments in Spreadsheet Link EX Functions”
on page 1-18.

Note Do not use the Excel Function Wizard. It can generate unpredictable
results.

After a Spreadsheet Link EX function successfully executes as a worksheet
formula, the cell contains the value 0. While the function executes, the cell
might continue to show the formula you entered.

To change the active cell when an operation completes, click Excel Tools
Options > Edit > Move Selection after Enter. This action provides a
useful confirmation for lengthy operations.

Automatic Calculation Mode Vs. Manual Calculation Mode
Spreadsheet Link EX functions are most effective in automatic calculation
mode. To automate the recalculation of a Spreadsheet Link EX function, add
to it a cell whose value changes. In the following example, the MLPutMatrix
function reexecutes when the value in cell C1 changes:

=MLPutMatrix("bonds", D1:G26) + C1

Note Be careful to avoid creating endless recalculation loops.

To use MLGetMatrix in manual calculation mode:

1 Enter the function into a cell.
2 Press F2.

3 Press Enter. The function executes.
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Spreadsheet Link EX functions do not automatically adjust cell addresses.
If you use explicit cell addresses in a function, you must edit the function
arguments to reference a new cell address when you do either of the following:

® Insert or delete rows or columns.

e Move or copy the function to another cell.

Note Pressing F9 to recalculate a worksheet affects only Excel functions.
This key does not operate on Spreadsheet Link EX functions.

Working with Arguments in Spreadsheet Link EX
Functions

This section describes tips for managing variable-name arguments and
data-location arguments in Spreadsheet Link EX functions.

Variable-Name Arguments
® You can directly or indirectly specify a variable-name argument in most
Spreadsheet Link EX functions:

= To specify a variable name directly, enclose it in double quotation marks;
for example, MLDeleteMatrix("Bonds").

= To specify a variable name as an indirect reference, enter it without
quotation marks. The function evaluates the contents of the argument to
get the variable name. The argument must be a worksheet cell address
or range name; for example, MLDeleteMatrix (C1).

Data-Location Arguments

® A data-location argument must be a worksheet cell address or range name.

® Do not enclose a data-location argument in quotation marks (except in
MLGetMatrix, which has unique argument conventions).

e A data-location argument can include a worksheet number; for example,
Sheet3!B1:C7 or Sheet2!OUTPUT.
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Note You can reference special characters as part of a worksheet name in
MLGetMatrix or MLPutMatrix by embedding the worksheet name within
single quotation marks ('").
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Using the MATLAB Function Wizard for the
Spreadsheet Link EX Software

The MATLAB Function Wizard for the Spreadsheet Link EX software allows
you to browse MATLAB directories and run functions from within the Excel
interface.

List functions available Display list of MATLAB working directories
for specified directory/category and available function categories
MATLAE Function Wizard ==

MATLAB

worw marhwaorks com

—_

. Select 3 category:

| matlab\elmat - Elementary matrices and matrix mani;j |Update

. Select a function:

pascal ﬂ

permuke
i

ra

. Select a function signature:

RAMD(M,M,P, ...}
RAMD(METHOL
RAMD({METHOD, 5%

RAND(NY Rd

Function Help:

RAMD [ Uniformly distributed pseudo-random numbers, -
R = RAMNDIN) returns an M-by-M matrix containing pseudo-random values
drawpn From & uniform distribution on the unit interval. RAMDIM, M)
ar RBMDTM, MT) returns an M-be-M matriz, RAMDIM,M,P,...) or
RARDET M, M P, L) Feturns an M-by-h-by-P-by-... array, RAND with
no apguments returns a scalar, RANDSIZECA)) returns an array the

same size as A,
-l
QK J

Select function signature Display heip for given Refresh
and enter formula into function signature directory/category list
specified spreadsheet cell
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You can use this wizard to:

1 Display a list of all MATLAB working directories and function
categories

All directories or categories in the current MATLABPATH display in the Select
a category field. Click an entry in the list to select it. Each entry in the
list displays as a folder path plus a description read from the Contents.m
file in that folder. If no Contents.m file is found, the folder/category display
notifies you as follows:

finance\finsupport -(No table of contents file)
To refresh the folder/category list, click the Update button.

2 Choose a particular folder or category, and list functions available
for that folder or category

After you select a folder or category, available functions for that folder or
category display in the Select a function field. Click a function name
to select it.

3 Parse a specified function signature and enter a formula into the
current spreadsheet cell

After you select a function, available function signatures for the specified
function display in the Select a function signature field. Click a function
signature to display the Function Arguments pane.

1-21



1 Getting Started

Scroll through list of

Specify cell for function output
function input arguments

(optional)
MATLAB Functicn ¥\ EZ
B-
wewew. mathworkcom
1. Select a category:
| matlablzlmat - Eleméqtary matrices and makrix manip - | Update |
Function Arguments ==

RAMD Inputs:

M| =

Cptional oukput cell{s): |

RAND  Uniformby diskributed pseudo-random numbers.,
R = RAMD{M) returns an M-byw-R matriz containing pseudo-randam values

drawn Fram a uniform distribution on the unit interval, RANDIN, M)
ar RAMNDM, M) returns an M-by-M matriz, RAMDOM, MNP, oF
RANDOM,M,P, ... T) returns an M-bey-M-by-P-by-. array, RAND with J

FY
FY
-

drawn From & uniform distribution on the unit interval. RAMDIM, M)
or RAMDIM,MT) returns an M-by-M matrix, RANDIM,MN,P,... ) 0
RAMDIM, M, P, . 10 returns an M-by--by-P-by-... array, RAND with
no arguments returns a scalar, RAND{SIZECA)) returns an arrgy the

same size as &,
=

814

Enter function arguments

Double-click function signature
to display Function Arguments pane ...
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By default, the output of the selected function appears in the current
spreadsheet cell using the Spreadsheet Link EX function matlabfcn. In
the following example, the output displays in the current spreadsheet cell
and generates a MATLAB figure:

=matlabfcn("plot",Sheet1!$B$2:$D$4)

Specifying a target range of cells using the Optional output cell(s) field
in the Function Arguments dialog box causes the selected function to
appear in the current spreadsheet cell as an argument of the matlabsub
function. In addition, matlabsub includes an argument that indicates
where to write the function’s output. In the following example, the data
from A2 is input to the rand function, whose target cell is B2:

=matlabsub("rand", "Sheet1!$B%2",Sheet1!$A$2)

4 Display online help headers for functions

After you select a function signature from the Select a function
signature field, its help header appears in the Function Help field.

Examples: Using Spreadsheet Link EX Functions in
Macros

About the Examples
This section contains examples that show how to manipulate MATLAB data
using Spreadsheet Link EX.

For an example of how to exchange data between the MATLAB and Excel
workspaces, see “Importing and Exporting Data between the Microsoft®
Excel Interface and the MATLAB Workspace” on page 1-26.

For an example of how to export data from the MATLAB workspace and
display it in an Excel worksheet, see “Sending MATLAB Data to an Excel
Worksheet and Displaying the Results” on page 1-24.
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Sending MATLAB Data to an Excel Worksheet and Displaying
the Results

In this example, you run MATLAB commands using VBA, send MATLAB
data to the Excel software, and display the results in an Excel dialog box.

1 Start an Excel session.

2 Initialize the MATLAB session by clicking the startmatlab button in the
Spreadsheet Link EX toolbar or by running the matlabinit function.

3 If the Spreadsheet Link EX Add-In is not enabled, enable it.

¢ For instructions on enabling this Add-In for the Excel 2003 software, see
“Configuring Version 2003 and Earlier Versions of the Microsoft® Excel
Software” on page 1-5.

® For instructions on enabling this Add-In for the Excel 2007 software, see
“Configuring Version 2007 of the Microsoft® Excel Software” on page 1-7.

4 Enable the Spreadsheet Link EX software as a Reference in the Microsoft®
Visual Basic® editor.

a Open a Visual Basic® session.

e If you are running the Excel 2003 software, click
Tools > Macro > Visual Basic Editor.

¢ [f you are running the Excel 2007 software, click the Visual Basic
button, o , or press Alt+F11.

b In the Visual Basic toolbar, click Tools > References.

¢ In the References — VBA Project dialog box, select the
SpreadsheetLinkEX check box.

d Click OK.

5 In the Visual Basic editor, create a module.

a Right-click the Microsoft Excel Objects folder in the Project —
VBAProject browser.

b Select Insert > Module.
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6 Enter the following code into the module window:

Option Base 1
Sub Method1 ()

MLShowMatlabErrors "yes"

"'"'"To MATLAB:
Dim Vone(2, 2
Vone(1, 1)
Vone(1, 2) =
Vone(2, 1)

Vone(2, 2)

As Double "Input

|
AWM =—

MLPutMatrix "a", Range("A1:B2")
MLPutVar "b", Vone
MLEvalString ("c = a*b")
MLEvalString ("d = eig(c)")

"'*'"From MATLAB:

Dim Vtwo As Variant "Output
MLGetVar "c", Vtwo

MsgBox "c is " & Vtwo(1, 1)

MLGetMatrix "b", Range("A7:B8").Address
MatlabRequest

MLGetMatrix "c", "Sheet1!A4:B5"
MatlabRequest

Sheets("Sheet1").Select
Range("A10").Select

MLGetMatrix "d", ActiveCell.Address
MatlabRequest

End Sub

Tip Copy and paste this code into the Visual Basic editor from the HTML
version of the documentation.
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7 Run the code. Press F5 or click Run > Run Sub/UserForm.

The following dialog box appears.

Microsoft Excel @

cisl

oK

8 Click OK to close the dialog box.

Note Do not include MatlabRequest in a macro function unless the macro
function is called from a subroutine.

Tip In macros, leave a space between the function name and the first
argument; do not use parentheses.

Importing and Exporting Data between the Microsoft Excel
Interface and the MATLAB Workspace

¢ This example uses MLGetMatrix in a macro subroutine to export data from
the MATLAB matrix A into the Excel worksheet Sheet1.

Sub Testi1()
MLGetMatrix "A", "Sheet1!A5"
MatlabRequest

End Sub
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Note The MatlabRequest function initializes internal Spreadsheet Link
EX variables and enables MLGetMatrix to function in the subroutine.

¢ This example uses MLPutMatrix in a macro subroutine to import data into
the MATLAB matrix A, from a specified cell range in the Excel worksheet
Sheet1.

Sub Test2()
Set myRange = Range("A1:C3")
MLPutMatrix "A", myRange

End Sub

Working with Dates

Default Microsoft Excel date numbers represent the number of days that have
passed since January 1, 1900; for example, May 15, 1996 is represented as
35200 in the Excel software.

However, MATLAB date numbers represent the number of days that have
passed since January 1, 0000, so May 15, 1996 is represented as 729160 in
the MATLAB software. Therefore, the difference in dates between the Excel
software and the MATLAB software is a constant, 693960 (729160 minus
35200).

To use date numbers in MATLAB calculations, apply the 693960 constant as
follows:
e Add it to Excel date numbers that are read into the MATLAB software.

e Subtract it from MATLAB date numbers that are read into the Excel
software.

Note If you use the optional Excel 1904 date system, the constant is
695422,
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Dates are stored internally in the Excel software as numbers and are
unaffected by locale.
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Localization Information

Localization Information

This document uses the Microsoft Excel software with an English (United
States) Microsoft Windows regional setting for illustrative purposes. If you
use the Spreadsheet Link EX software with a non-English (United States)
Windows desktop environment, certain syntactical elements may not work as
illustrated. For example, you may have to replace the comma (,) delimiter
within Spreadsheet Link EX commands with a semicolon (;) or other operator.

Please consult your Windows documentation to determine which regional
setting differences exist among non-U.S. versions.
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Solving Problems with
the Spreadsheet Link EX
Software

¢ “Running the Examples” on page 2-2

¢ “Modeling Data Sets Using Data Regression and Curve Fitting” on page 2-3
¢ “Interpolating Data” on page 2-11

® “Pricing Stock Options Using the Binomial Model” on page 2-15

e “Calculating and Plotting the Efficient Frontier of Financial Portfolios”
on page 2-19

e “Mapping Time and Bond Cash Flows” on page 2-23

Note For other applications, see “Using Spreadsheet Link EX with
Bioinformatic Data”.
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Running the Examples

The following sections show how the Microsoft Excel, Spreadsheet Link EX,
and MATLAB software work together to solve real-world problems.

These examples are included with the Spreadsheet Link EX product. To run
them:

1 Start Excel, Spreadsheet Link EX, and MATLAB sessions.
2 Navigate to the folder matlabroot\toolbox\exlink\.
3 Open the file Ex1iSamp.x1ls

4 Execute the examples as needed.

Note Examples 1 and 2 use MATLAB functions only. Examples 3, 4, and 5
use Financial Toolbox™ functions. The Financial Toolbox software requires
the Statistics Toolbox™ and Optimization Toolbox™ products.
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Modeling Data Sets Using Data Regression and Curve

Fitting

In this section...

“Using Worksheets” on page 2-3

“Using Macros” on page 2-6

Regression techniques and curve fitting attempt to find functions that
describe the relationship among variables. In effect, they attempt to build
mathematical models of a data set. MATLAB matrix operators and functions
simplify this task.

This example shows both data regression and curve fitting. It also executes
the same example in a worksheet version and a macro version. The
example uses Microsoft Excel worksheets to organize and display the data.
Spreadsheet Link EX functions copy the data to the MATLAB workspace, and
then executes MATLAB computational and graphic functions. The macro
version also returns output data to an Excel worksheet.

Using Worksheets

1 Click the Sheetl tab on the Ex1iSamp.x1ls window. The worksheet for
this example appears.
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AV A =T
—Lif Home Insert Page Layout Formulas Data Review Wi e Add-Ins
| E29 - £ |
A B C | D | E | E | G | H | J | K| I
1 |Regression and Curve Fitting
i
3 DATA Spreadsheet Link EX Functions
4 35 207 1325 1. Transfer the data to MATLAB.
5 17 20 533 0 «<== MLPutMatrix("data" DATA)
5 43 180 13
7 4 187 1163 2. Set up data for regression.
a 177 452 5326 0 === MLEvalString("y = data(: 31"
4 57 354 2043 0 === MLEvalString("e = ones(length(data), 11"
10 20 1m 602 0 === MLEvalString("A = [e data(:,1.2)]")
11 13 Ll 532
12 17 86 543 3. Compute regression coefficients
13 ] 180 1134 0 «== MLEvalString("beta = Aly")
14 28 136 766
15 17 84 495 4. Calculate regressed result
16 23 102 B35 0 === MLEvalString("fit = A%beta")
17 24 145 913
18 40 292 1591 5. Compare original data with regression results.
19 25 126 671 0 === MLEvalString("[y k] = sort{y)")
20 17 ais] 521 0 === MLEvalString("fit = fit(k)")
21 46 235 1319 0 === MLEvalString("n = size{data, 11"
22 37 204 1038
23 ] 68 458 B. Use MATLAB's polynomial solving functions for another curve fit.
24 g5 363 2904 0 «== MLEvalString("[p,3] = polyfit(1:n,y' 51"
25 66 300 2006 0 === MLEvalString("newfit = polyval(p,1:n,51"
26 39 161 938
27 m 459 3282 7. Plot curves and add legend
28 16 &0 A7E 0 === MLEvalString("plot(1:ny,'bo' 1:n fit,r:" 1:n,newdit,'s’); legendi{’data’,fit’ newdfit’)")

The worksheet contains one named range: A4:C28 is named DATA and
contains the data set for this example.

Make E5 the active cell. Press F2; then press Enter to execute the
Spreadsheet Link EX function that copies the sample data set to the
MATLAB workspace. The data set contains 25 observations of three
variables. There is a strong linear dependence among the observations; in
fact, they are close to being scalar multiples of each other.

Move to cell E8 and press F2; then press Enter. Repeat with cells E9 and
E10. These Spreadsheet Link EX functions regress the third column of data
on the other two columns, and create the following:

® A single vector y containing the third-column data.

¢ A three-column matrix A, that consists of a column of ones followed by
the rest of the data.
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4 Execute the function in cell E13. This function computes the regression
coefficients by using the MATLAB back slash (\) operation to solve the
(overdetermined) system of linear equations, A*beta = y.

5 Execute the function in cell E16. MATLAB matrix-vector multiplication
produces the regressed result (fit).

6 Execute the functions in cells E19, E20, and E21. These functions do the
following:

a Compare the original data with fit.
b Sort the data in increasing order and apply the same permutation to fit.

¢ Create a scalar for the number of observations.

7 Execute the functions in cells E24 and E25. Often it is useful to fit a
polynomial equation to data. To do so, you would ordinarily have to set up
a system of simultaneous linear equations and solve for the coefficients.
The MATLAB polyfit function automates this procedure, in this case for a
fifth-degree polynomial. The polyval function then evaluates the resulting
polynomial at each data point to check the goodness of fit (newfit).

8 Execute the function in cell E28. The MATLAB plot function graphs the
original data (blue circles), the regressed result fit (dashed red line), and
the polynomial result (solid green line). It also adds a legend.
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Since the data is closely correlated but not exactly linearly dependent, the
fit curve (dashed line) shows a close, but not an exact, fit. The fifth-degree
polynomial curve, newfit, is a more accurate mathematical model for the data.

When you finish this version of the example, close the figure window.

Using Macros

1 Click the Sheet2 tab on Ex1iSamp.x1s. The worksheet for this example
appears.
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@) @2 c-DE@)
]
— Home Insert Page Layout Faormulas L
2 - £ |
| A B c Bl E
Regression and Curve Fitting Macro
(See Module 1) I _l

0 === CurveFit(DATA "A7" "B7","C7")

y fit newdfit

2 Make cell A4 the active cell, but do not execute it yet.

Cell A4 calls the macro CurveFit, which you can examine in the Microsoft
Visual Basic environment.
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E Microsoft Visual Basic - Copy of ExliSampxls - [Modulel {Code)]
%E\\e Edit  View Insert Faormat Debug  Run  Tools  Add-Ins  MWindow  Help

EE-d V-9 bou 3 S® W @ Lnt, ot
ProJect-‘ExiiSamp ﬁ |(General)

ﬂ |(I]el:laratinns)

= =N | - [

E @ ExliSamp (Copy of Exlisamp.xls)
75 Microsoft Excel Objects

--BH] Sheet3 (sheet3)

@ Sheett (Sheett) MLEwal3tring "n

MLEvalString ™i

End Function

Properties - Modulel

Ldix

[Module1 Madule
Alphabetic | Categarized |
Modulel

Bﬂ Sheet1 (Shestl) Function CurveFit(abata, sTargetl, sTargeti, sTargetd)
@ Sheet2 (Sheet2) 'MATLABR regression and curve fitting macro

@ Sheet4 (Sheet4) MLPutMatrix "data", aData
Bﬂ Sheets (Shests) MLEvalZtring "v = data(:,3)"

= lengthiy]"
@ This'Waorkbook MLEvalZtring "e = ones(n,1)"

= [e data(:,1:2)]"
MLEvalString "beta = Byy"
[ MLEval3tring "fit = A%heta"™
E@ SpreadsheetLinkEX (excllink.xla) MLEvalString "[v.k] = sorciy)™
MLEval3tring "fit = fitik)"™
MLEwval3tring "[p,5] = polyfit(l:n,v',5)"
MLEval3tring "newfit = polyvalip,l:n,3)'"™
MLEwval3tring "plot(l:n,v,'bo',l:n,fic, 'r:',1:n,newfic, 'g');legend('data', '£it', 'newfic' )"
MLGetMatrix "y", sTargetl
MLGetMatrix "fit", sTargetl
MLGetMatrix "newfit", sTargeti

3 While this module is open, make sure that the Spreadsheet Link EX add-in

is enabled.

¢ If you are using the Excel 2003 software:

a Click Tools > References.

b In the References dialog box, make sure that the excllink.xla

check box is selected. If not, select it.

¢ Click OK.

¢ If you are using the Excel 2007 software:

d Click the Microsoft Office Button, '
e Click Options. The Excel Options pane appears.

f Click Add-Ins.
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g From the Manage selection list, choose Excel Add-Ins.

h Click Go. The Add-Ins pane appears.

i Make sure that the Spreadsheet Link EX 3.0.1 for use with
MATLAB check box 1s selected. If not, select it.

Add-ins | 7] x]

Add-Ins available:

[ Analysis ToolPak =] oK.
[ Analysis ToolPak - VBA
] Conditional Sum Wizard Cancel
F Euro Currency Tools
Internet Assistant VBA

[ Lookup Wizard Browse. .
[ Solver Add-in

B4l Spreadsheet Link EX 3. 1 for use with MATLAB and Excel 2007

s

Autormation, ..

[

preadsheet Link EX 3. 1 for use with MATLAB and Excel 2007
Spreadsheet Link EX 3.1 for use with MATLAB and Excel 2007

i Click OK to close the Add-Ins pane.
k Click OK to close the Excel Options pane.
4 In cell A4 of Sheet2, press F2; then press Enter to execute the CurveFit
macro. The macro does the following:

a Runs the same functions as the worksheet example (in a slightly
different order), including plotting the graph.

b Calls the MLGetMatrix function in the CurveFit macro. This macro
copies to the worksheet the original data y (sorted), the corresponding
regressed data fit, and the polynomial data newfit.
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(a1 i JEE) -
— Home Insert Page Layout Formulas L
N GEN L EN LN 5 ]
SRS EE RN = 2 =
From  From  From  From Other Existing Refresh
Access Web  Text  Sowrces T | Connections Al
Get External Data Canr
| 85 - Lol
A B c D E

Regression and Curve Fitting Macro
(See Module 1)

1

2

3

4 0 <== CurveFit[DATA,"A7" "B7","CT")
5 :I

5} y fit newfit
7 458 | 379.0475 | 402.008
a8 476 | 430.3099 | 515.8528
g 495 | 4624722 | 549.7114
10| 521 472.0222 | 543.0184
1 532 | 501.7971]524.5499
12| 533 |476.7973| 513.775
13| 543 | 467.2472 | 522.2081
14| BO2 |570.89658 | 554.761
15| B35 6411212 | 611.0947
16| B71 743.6461 | 6B6.9715
17| 7BE | 767.5211 | 775.6072
18| 913 |773.5589| B69.023
19| 938 1143.781 | 959.3974
20| 1013 |1279.593 ] 1040.419
21| 1038 |1201.219] 1108.636
22| 1134 |1098.695| 1164.812
23| 1183 |1251.081]1215.276
24| 1319 | 1478743 1273.275
25| 1325 | 11B63.157 | 1360.322
26| 1591 | 1479.157 | 1507.557
27| 20068 |20BB5.177| 1757.09
28| 2043 |2011.592]2163.358
29| 2904 |Z26B5.224|2794.475
30| 3282 |34B83.345]3733.586
31| 5326 | 5197.796 ) 5080.215

2-10



Interpolating Data

Interpolating Data

Interpolation is a process for estimating values that lie between known data
points. It is important for applications such as signal and image processing

and data visualization. MATLAB interpolation functions let you balance the
smoothness of data fit with execution speed and efficient memory use.

This example uses a two-dimensional data-gridding interpolation function
on thermodynamic data, where volume has been measured for time

and temperature values. It finds the volume values underlying the
two-dimensional, time-temperature function for a new set of time and
temperature coordinates.

The example uses a Microsoft Excel worksheet to organize and display the
original data and the interpolated output data. You use Spreadsheet Link
EX functions to copy the data to and from the MATLAB workspace, and then
execute the MATLAB interpolation function. Finally, you invoke MATLAB
graphics to display the interpolated data in a three-dimensional color surface.

1 Click the Sheet3 tab on Ex1iSamp.x1s. The worksheet for this example
appears.
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42
2
44
45
1€
47
4
43
50

B | DERE -~ Copy of ExliSarnp [Cormpatibility Mode] - Micrasoft Bxcel
Haome Insert Page Lavout Formulas Data Review Wiew Add-Ins
=5 iy sy 5 Bl connedions | & 5T f =1 = s o i T LANE
. A |2 Hez 4 W=
8 =E i 13 @ : - i3]z L =5 B = Jf;\ Ej‘) e
From  From  From Other Existing Refresh B il Sort Filter \‘,’ ) Textto  Remowe Data Consolidate  What-If Group
Web  Text  SourcesT | Connections All- 5= Editlinks 7 tdvanced || columns Duplicates Validation ~ Analysis -
et Bxternal Data Connectinhs Sart & Filter Data Toals

£33 - | S | =hALPUtRatrix("Labels", A4:C4)

A E i £} E F G H 1 J K L (7] k [=] F [F] R ) aF

Data Interpolation

Original Data Interpolated Yalues
Time  Temp  Yolume
0025 G200 250408 Temp
0050 A0S 253507 Time 520 685 530 895 0.0 705 70 75 720 725 730 735 740 745 750
458000 37805 40201 0025
4TEO00 43031 61535 [
435000 45247 5497 0.075
521000 47202 54302 [
532000 50130 52458 0uiz5|
533000 47830 G577 0.15)
543000 46725 6a2al 0.175]
602000 57030 G547E 03
635000 B4llz BHO3 0.225
E7I000  THREE  E8RAT 0.25]
TEBOOD  TETEZ 7750 0.275
913000 7TASE  seAN2 03
938000 14378 95940 0.325
1013000 127959 104042 0.35]
038000 120122 10864 0375
N300 109889 fe4.8t 04
63000 125108 1215.28 0425
1318000 WTRT4 12TaET 0.45]
#5000 fB3ME 136032 0475
1591000 147906 150756 05|
2008000 208618 I7ST.08 0525
2043000 201153 26338 055
2904000  26EEZZ  2734AE 0575
82 MERME 37358 05|

5326 G197.796 G020.215
1 _Transfer original data to MATLAE.

2. Transfer interpolation data points to MATLAE.
0 <== MLPutMatis]"}a"EFE30)
0 ¢== MLPutMatrisl "T4"F6:T6)

3. Evecute MATLAE data interpolation function.
#COMMA == MLEvalString["[l. T, ¥1] = griddata(:T.¥.%a.T 2, inedistT)

4. Transpose output data matrix and transter data to Exoel
#COMMA, == MLEwalString["1¥ = ¥17")
HMOMERE <== MLGetMatria 10", F7")

5. Flot interpolated data and Label the figure.
$COMME <=z MLEwalStrinal"surf(, T, Yiltitlelinterpolated Diata'kilabeliL abels{ 1l abelfL abels {2 zlsbeliL abelsi3! karid on”|

The worksheet contains the measured thermodynamic data in cells A5:A29,
B5:B29, and C5:C29. The time and temperature values for interpolation
are in cells E7:E30 and F6:T6, respectively.

2 Make A33 the active cell. Press F2; then press Enter to execute the
Spreadsheet Link EX function that passes the Time, Temp, and Volume
labels to the MATLAB workspace.

3 Make A34 the active cell. Press F2; then press Enter to execute the
Spreadsheet Link EX function that copies the original time data to the
MATLAB workspace. Move to cell A35 and execute the function to copy the
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original temperature data. Execute the function in cell A36 to copy the
original volume data.

Move to cell A39 and press F2; then press Enter to copy the interpolation

time values to the MATLAB workspace. Execute the function in cell A40 to
copy the interpolation temperature values.

5 Execute the function in cell A43. griddata is the MATLAB two-dimensional
interpolation function that generates the interpolated volume data using
the inverse distance method.

Execute the functions in cells A46 and A47 to transpose the interpolated

volume data and copy it to the Excel worksheet. The data fills cells F7: T30,

which are enclosed in a border.

Time

Interpolated Walues

0.025)
0.05}
0.075)
01
0,125
0.15)
0.175

0.225
0.25
0.275

0.325)
0.35)
0.375)
0.4]
0.425)
0,454
0.475)

0.525)
0.55)
0.575)

Temp

E2.0 23] E9.0 £9.5 70.0 705 Fall] Faks 70 Frdi) 730 Feki) 740 745 750
2604.02 270023 286095 Z00EEZ 4492 JITTAZ 40445 3EITEI JB4T22 ITEILE  3OTY.ED 290904 403212 4205.14 4310.24
ZEOS.TZ  ZT0A3T  ZEEIE1 300983 3MEI2 328003 340736 363043 366001 3TEESZ 333023 399167 H00E1  4207HE 431263
251527 270823 28E7.04 Imzzz 25125 J28213 341024 363323 3EBLTR ITEAIT mE2aeY 393410 4102.03 421001 4315.02]
2620.45 271214 237053 IMEA43 5426 JZLE1E 24131 352602 JEEL44 ITTIE1 383646 399EED 410557 421244 431740
2525.29 271691 237399 IMaT4 JET AR 328913 341638 363280 JEERN4 3TT444 2EBRO2 399315 4102.03 421426 4313.78
2629.89 271962 287741 302297 JE0ET 323209 41084 JB4167  3JEE0S4  3TTTO0T 320063 400166 410,50 4217.28 432215
263431 272226 2880.21 J0ZE.13 JE3EI 323503 J42168 364433 3BE3HI  3TTIED 329215 400417 412,96 421963 432452
263862 2T2ER0 288416 302936 JEEET 329796 342452 364702 JEEE.21 areem 329571 400EET 41541 422210 432629
B4272 ITI0ZG ZBSTAE 303252 MMESEE 330088 2T 354982 66383 TS 339326 400007 4HTEE 422450 432925
254677 273371 289077 Z03GEE JTZET  3302TE 343016 36B2EE JETIE4 ITETEL 290020 401166 412030 422690 4331E]
ZBB0.74  ZTIT.OT ZBO40Z  303BTFT MTEEE 330667 343296 365528 3643 3TI0N 390334 404 HI2ETI 422923 433395
2BE4.62 274036 289723 04126 JIT2E4 320985 343576 3BGR00  3EYES4  ITIZEI 2A0GET 401662 412517 423168 4232620
206244 274353 2900.41 304493 160 INZ4 343853 3DEOTO JETO4E ITIR2T 2A02.23 4019.09 412753 422405 422264
2BEZ.20  2T4EFT  2A03BE 30477 312454 3526 344129 3RE240 ILB2N ITITE4 910,90 402156 412001 423644 434099
2BEB.O0 274983 20BEF 206033 AT 4E IM20 344405 2IBEEDS  IEB4TI 320040 924 402402 413242 423881 43423
2BEABE  2TB2A7 230974 205332 037 332092 44620 3WERTE  IBOTI4 200296 395,92 402647 4134.82 424107 424564
267316 2TEE0N0 291278 308E9E JAT2E IB2TI 44452 57142 362995 380650 924 402892 413724 4242054 424796
ZBTETZ 2FEA.00 291679 305990 39613 332652 M4E225 367408 369254 320204 392090 403136 MI9E3 424589 435028
2680.24 276195 291376 306283 319898 332930 346498 3ETETZ JED5.13 I2052 392238 403280 44203 424824 435259
ZBE3.TZ ZTE4ST 292170 306573 320081 333206 MGTEE 367936 3BOTV1 381300 3925.86 403623 4441 425053 435490
26877 2TETTE 292461 J0EEE1 320463 333482 46034 3BE198 IT002Y JBBEZ 392833 403266 4METI 425293 435720
2690.62 277061 232749 J0TI4E 320743 333TEE 346302 362460 3T02B4 321213 393079 4041.06 41317 428526 435350
2693096 277344 283024 207423 32021 334028 34EGED JBET.Z1 ITOG3S ZE20E3 393224 404343 4161564 425753 436179
2697.31  27TE24 293216 07710 321298 334298 346233 362980 370743 322212 392663 404688 416390  4269.92 436405

7 Execute the function in cell A50. The MATLAB software plots and labels
the interpolated data on a three-dimensional color surface, with the color
proportional to the interpolated volume data.
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When you finish the example, close the figure window.
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Pricing Stock Options Using the Binomial Model

The Financial Toolbox product provides functions that compute prices,
sensitivities, and profits for portfolios of options or other equity derivatives.
This example uses the binomial model to price an option. The binomial
model assumes that the probability of each possible price over time follows a
binomial distribution. That is, prices can move to only two values, one up or
one down, over any short time period. Plotting these two values over time is
known as building a binomial tree.

This example organizes and displays input and output data using a Microsoft
Excel worksheet. Spreadsheet Link EX functions copy data to a MATLAB
matrix, calculate the prices, and return data to the worksheet.

Note This example requires the Financial Toolbox software.

1 Click the Sheet4 tab on Ex1iSamp.x1s to open the worksheet for this
example.
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En;...,' - dEE - Copy of ExiSarmp [Cormp:
_'"LU Home Insert Page Layout Formulas Data Review R Add-Ins
2 og Cut trial - <A A= = ‘@.—\ ;Wrap Text General » E
=E Lol = - 0 .00 Cond
Pavsta S Foiat Ak B 7 === || EadMerge & Center - | $ - %+ %08 B Foor:na
Clipboard (F} Alignment F} Mumber Pl
H3 -
A B C (8] E E G H d kK
1 |Binomial Option Pricing
ol
A hindata Spreadsheet Link EX Functions I -I
4 |Asset price, so § 52.00 1. Transfer data to MATLAB
5 | Option exercise price, x | $ 50.00 0 === MLPutMatrix("b", bindata)
G |Risk-free interest rate, v 10%
7 |Tirne to maturity, t (yrs) | 0.416667|=5/12 2. Execute MATLAB Financial Toolbox binomial option pricing function
8 |Time increment, dt 0.083333)=1/12 ACOMMAL <== MLEvalString("[p, o}=binprice(b(1), b(2), b(3), b4}, b(E), biB), b{FN"
9 Wolatility, sig 04
10 [ Call (1) or put (0), flag 0 3. Transfer output data to Excel.
11 #MONEXIE <== MLGetMatrix("p", "asset_tree”)
12 #MONEXIE <== MLGetMatrix("0", "value_tres")
13
14 Start Period 1 Period 2 Period 3 Period 4 Period &
15 Asset price tree, p () 0.01 0613 11971 857807 331.414 156731
16
17
18
18,
20
21
22
23 Option value tree, o (§)
24
25
]
ey
25

The worksheet contains three named ranges:

® B4:B10 named bindata. Two cells in bindata contain formulas:
- B7 contains =5/12
- B8 contains =1/12

® B15 named asset_tree.

® B23 named value_tree.

Make D5 the active cell. Press F2; then press Enter to execute the

Spreadsheet Link EX function that copies the asset data to the MATLAB

workspace.

3 Move to D8 and execute the function that computes the binomial prices.



Pricing Stock Options Using the Binomial Model

4 Execute the functions in D11 and D12 to copy the price data to the Excel
worksheet.

The worksheet looks as follows.

Do) id 9 - R ERE Copy of EdiSarap [Carmpi
—\i', Home Insert Page Lavout Formulas Data Review Wigwns Add-Ins
" "t Gk Arial 1w <A AT = Wirap Text General - _E
Paste A2 o] o = 8, =0 .00 Cond
i F Farmat Painter B I U~ A= FxMerge & Center = | | § v % v || %8 %8 Fuorqm
Clipboard £} Font £} Alignment e} Mumber £}
| D13 - £
A B i B] I F G H g K
1 |Binomial Option Pricing
2
& bindata Spreadsheet Link EX Functions
4 |Asset price, so § 5200 1. Transfer data to MATLAB.
5 Option exercise price, x | § 50,00 0 == MLPuthatrix("b", bindata)
E |Risk-free interest rate, r 10%
7 Time to maturity, t {yrs) | 0.416667|=5/12 2. Execute MATLAB Financial Toolbox binomial aption pricing function
g |Time increment, dt 0.083333|=1/12 0 === MLEvalString("[p, o]=binpriceib(1), b2}, bi3), b{4), bE), b{E), bFN"
9 olatility, sig 0.4
10 [Call (13 or put (0], flag o] 3. Transfer output data to Excel
11 0 «== MLGetMatrix("p", "asset_tree")
12 0 === MLGetMatrix("0", "value_tree")
13
14 Stat  Period 1 Period2 Period3  Period 4 Periad &
15 |Asset price tree, p ($) 52000 58365 B4S09 73527 82527 92620
16 0 45329 52000 58385 B5503 73527
17 0 0 4277 46328 52000 58.365
18| 0 0 0 36776 M7 46329
12 0 0 0 0 32765 36776
20 i} i} 0 0 0 259132
2
22
23 Option value tree, o (%) 3728 1.664 0.428 0 0 0
24 | 0 5.918 2.964 0.876 0 0
25 0 0 9.060 5.164 1.733 1]
26 i} i} 0 13224 8723 3671
7 0 0 0 0 17238 13224
28| 0 0 0 0 0 20.808

Read the asset price tree as follows:
® Period 1 shows the up and down prices.
® Period 2 shows the up-up, up-down, and down-down prices.

® Period 3 shows the up-up-up, up-up, down-down, and down-down-down
prices.

¢ And so on.
Ignore the zeros. The option value tree gives the associated option value for
each node in the price tree. The option value is zero for prices significantly
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2 Solving Problems with the Spreadsheet Link™ EX Software

above the exercise price. Ignore the zeros that correspond to a zero in the
price tree.

5 Try changing the data in B4:B10 and reexecuting the Spreadsheet Link
EX functions.

Note If you increase the time to maturity (B7) or change the time
increment (B8), you may need to enlarge the output tree areas.

6 When you finish the example, close the figure window.
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Calculating and Plotting the Efficient Frontier of Financial Portfolios

Calculating and Plotting the Efficient Frontier of Financial

Portfolios

MATLAB and Financial Toolbox functions compute and plot risks, variances,
rates of return, and the efficient frontier of portfolios. Efficient portfolios have
the lowest aggregate variance, or risk, for a given return.Microsoft Excel

and the Spreadsheet Link EX software let you set up data, execute financial
functions and MATLAB graphics, and display numeric results.

This example analyzes three portfolios, using rates of return for six time
periods. In actual practice, these functions can analyze many portfolios over
many time periods, limited only by the amount of computer memory available.

Note This example requires the Financial Toolbox software.

1 Click the Sheet5 tab on Ex1iSamp.x1s. The worksheet for this example
appears.
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2 Solving Problems with the Spreadsheet Link™ EX Software

1 '_-.!_:3 i, R =5 Copy of ExliSamp [Compatibility Mode] - b
Y
—/', Home Insert Page Layout Farmulas Data Review e Add-Ins
& Cut Arial i v (A aA || ==l S Wrap Text General - Eﬂl M |
=3 Copy EH 5
Paste - = - - 5 €0 ;90 Conditional Format
S Fromatpainter ||| B L e Mierae o[BS MR e Formatting - a3 Table -
Clipboard [ £l Alignment E} Rlumber £}
| 57 - [
A B (5] D E b G H | Jd
1 Portfolio Efficient Frontier
& Global Corp. Bnd Small Cap
3 |Rates of return Global  Corp. Bnd Small Cap Risk ROR  Weights
4 Mow-91] 7.125%  4.125% B3T5%
5 Mow-821 6126% 5128% 3.875%
4 Mow-93] -1.375%  6.750% 10.600%
7 Hov-84] 7.750% 6.000% 14.750%
g Hov-95] 8.250% 6.375% -3625%
) Mov-96) 12.625% 6.125%  9.125%
10
11
12

13 Spreadsheet Link EX Functions
14 1. Transfer data to MATLAB.

14 0 === MLPutMatrix("Labels", F3:G3)

16 0 === MLPutMatrix"retseries”, B4:D49)

17

18 |2. Execute MATLAB Financial Toolbox functions.

149 0 === MLEvalString('[ret, cov] = ewstats(retseries)")

20 #FCOMMAND! === MLEvalString[risk, rar, weights] = portoptiret, coy, 200"
il

22 |3. Transfer output data to Excel

23 [FMONERIST! === MLGetMatriz{"risk’, "F 4"}

24 [FNONEXIST! === MLGetatrix'ror", "G4")

26 |FNONEXIST! === MLGetMatrix"weights", "H4")

26

27 |4. Plot efiicient frantier data and label the figure

28 #FCOMMAND! === MLEvalString{" portoptret, cov, 20; grid on; xlahel{Labels{1}; vlabeliLabels{2H")

2 Make A15 the active cell. Press F2; then press Enter. The Spreadsheet
Link EX function transfers the labels that describe the output that the
MATLAB software computes.

3 Make A16 the active cell to copy the portfolio return data to the MATLAB
workspace.

4 Execute the functions in A19 and A20 to compute the Financial Toolbox
efficient frontier function for 20 points along the frontier.

5 Execute the Spreadsheet Link EX functions in A23, A24, and A25 to copy
the output data to the Excel worksheet.

The worksheet looks as follows.
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Calculating and Plotting the Efficient Frontier of Financial Portfolios

T 2 - DEeE )+ Copy of ExliSamp [Compatibility Mode] - M
—')j/J Home Insert Page Layout Formulas Data Revieuw Wiew Add-Ins
= * ot Arial 1w A AT | = =8| | SiwrapText General - ?gj
Paste FE I u- = ﬁ - $ -9 <0 .00/ Conditional Format
- J Farmat Painter =l s SR SR o 2| s Formatting = as Table =
Clipboard It Font i Alignment e} Mumber T
£26 - £ |
A B G 8] B B G H | il
1 Portfolio Efficient Frontier
2 Global Corp. Bnd Small Cap
3 Rates of return Glohal  Corp. Bnd Small Cap Risk ROR Weights
4 Mow-31] 7.1258% 4.128% B375% 0.730%| 5.643% 0.3% 96.1% 28%
g Hov-92] 5125%  5125%  3.875% 0.760%| 5.723% 4.0% 89.7% B.3%
B Mow-93] -1.375%  5.750%  10.500% 0.844%| 5.803% T7% 83.3% 9.0%
7 Mow-34| 7.780%  B.000% 14.750% 0.968%| 5.883% 11.3% 76.9% 11.8%|
2 Mow-35| 8.250% B378% -3.625% 1.118%| 5.964% 15.0% 70.5% 14.5%|
£ Mow-96) 12625% F126%  0135% 1.287%| B.044% 18.7% £4.0% 17.3%|
10 1.466%| 6.124% 22.3% 57.6% 20.0%)|
SHil 1.693%| 6.204% 26.0% 51.2% 22.8%|
12 1.846%| B.284% 29.7% 44.8% 25.5%|
13 |Spreadsheet Link EX Functions 2042%| B.365% 333% 38.4% 28.3%|
14 |1. Transfer data to MATLAB 2241%| B.445% I7T.0% 32.0% 31.1%|
14 0 === MLPulMatrix{"Lahels", F3:G3) 2.443%| 6.525% 40.6% 25.6% 33.8%|
16 0 === MLPutMatrix("retseries", B4:09) 2646%| B.608% 44.3% 19.1% 36.6%|
17 2.850%| B.B35% 48.0% 12.7% 39.3%|
18 |2, Execute MATLAB Financial Toolbox functions 3.055%| B.766% a1.6% B.3% 42.1%|
139 0 <== MLEvalString('[ret, cov] = ewstats(retseries)) 3262%| 6.846%| 550% 0.0%  450%,
0 0 === MLEvalString("[risk, ror, weights] = portopt(ret, cov, 200" 3.620%| B6.926% 41.3% 0.0% 48.7%|
21 4.213%| 7.006% 27.5% 0.0% 72.5%,
22 3. Transfer output data to Excel. 4.955%| 7.086% 13.8% 0.0% 86.2%|
23 0 === MLGethatrix"risk’, "F4") 5701%) 7167% 0.0% 0.0%  100.0%|
24 0 === MLGetMatrixror", "G4
25 0 === MLGetMatrixweights", "H4")
26

27 3. PIot eMcient fonter data and label the figure
28 [FCOMMANDI

The data describes the efficient frontier for these three portfolios: that set
of points representing the highest rate of return (ROR) for a given risk. For

=== MLEvalString("portoptiret, cov, 20); grid on; xiabeliLabels{1}}; yiabeliLabels{2)")

each of the 20 points along the frontier, the weighted investment in each
portfolio Weights) would achieve that rate of return.

Now move to A28 and press F2; then press Enter to execute the Financial

Toolbox function that plots the efficient frontier for the same portfolio data.

The following figure appears.
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Efficient Frontier
File  Edit View Insert Tools Desktop Window Help

DedES h RAN® | E 08 50

Mean-variance-Efficient Frontier

0.074 ! ! ,
0.072 | I

0.07
0.068

0.066

ROR

0.064

0.062

0.058

0.056

] 0.01 0.02 0.03
Risk

The light blue line shows the efficient frontier. Note the change in slope
above a 6.8% return because the Corporate Bond portfolio no longer

contributes to the efficient frontier.

7 To try running this example using different data, close the figure window
and change the data in cells B4:D9. Then reexecute all the Spreadsheet
Link EX functions. The worksheet then shows the new frontier data, and

0.04 0.05 0.06

the MATLAB software displays a new efficient frontier graph.

When you finish this example, close the figure window.
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Mapping Time and Bond Cash Flows

Mapping Time

and Bond Cash Flows

This example shows how to use the Financial Toolbox and Spreadsheet Link
EX software to compute a set of cash flow amounts and dates, given a portfolio
of five bonds with known maturity dates and coupon rates.

1 Click the Sheet6 tab on Ex1iSamp.x1s. The worksheet for this example

appears.
-m;_, =R DEg - Caopy of EdiSarmp [Cornpatibility Mode] - Microsoft E
]
-/ Home Insert Page Layout Farmulas Data P et Wiew Add-Ins
= & cut Arial - [3a-| | Sivrap Text General - E‘J 3/ |Nm’ma|
=3 Copy E: -
aste B I U ~|| & =a1 Merge & Center = $ - % o |58 5% cConditional Format  peutral
~ J Format Fainter e e 2 0 >0 Farmatting = a3 Table -
Clipbnard £} Font ] Alignment F] Mumber (E]
| Q38 - |
A E L2 D E F G H il K L M ]

N A PV,

11
12
13
14
15
16
17
18
19
20

22
23
24
25
26
27
25
29
30
kil
32
33
34

36
37

Cash Flow and Time Mapping for a Portfolio of Bonds
Cash Flow Dates

Settlement Date 2B-Jul-99 Bondi
Bond2

Bond Data Bond3

Bond4

Maturity Coupon Rate Bondd

Bondi 15-Mov-99 (0.05675
Bond2 15-May-00 0.08375

Bond3 15-Nov-00 0.08500
Bond4 15-May-01 0.08000
Bond3 15-Mov-D1 0.15750 Cash Flow Amounts
Bond1
Bond2
Spreadsheet Link EX Functions Bond3
1. Transfer data to MATLAB Bondd
0 === MLPutMatrix("maturity" "Maturity’) Bondd
0 === MLPutMatrix("cpnrate” "CpnRate")
0 == MLPutMatrix("sd",C3)
2. Execute MATLAB Financial Toolbox Cash flow and Tire mapping function

FCOMMAN <== MLEvalString("md = ¥2mdate(maturity 0); sdm = sx2mdate(sd 07"
HCOMMAR <== MLEvalString{"[cfa, cfd] = cfamounts(cpnrate, sdm, md, 2)")

3. Transform date numbers to string cell array

#OOMMAR <== MLEvalString("i = findiisnan(cfd)); zcfd = cfd; zefd(l) = 0, scfd=datestrizcfd 2);")
HCOMMAR <== MLEvalstring("ccfd = numZ2cell(zcfd 2); cofd(i) = {NAY, cofd = reshape(ccfd, size(cfd)),")
HCOMMAR <== MLEvalString("ccfa = cfa; cofai) = 0; alldates = ccfdiend, :3;")

4. Transfer output data to Excel

H#UONEXS «== MLGetMatrix("ccfd”, "i3")
HIOMNEXIS === MLGetMatrix("alldates", "i13")
H#UONEXIS <== MLGetMatrix("ccfa”, "i14")

5. Plot the cash flow diagram
HCOMMAR <== MLEvalString("cfplot(cfd, cfa), dtaxis(%'B,sdm S0) title("Cash Flow Diagram’);xlabel{Cash Flow Dates'); ylabel(Bonds’,")

2 Make A18 the active cell. Press F2, then Enter to execute the Spreadsheet
Link EX function that transfers the column vector Maturity to the
MATLAB workspace.
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2-24

3 Make A19 the active cell to transfer the column vector Coupon Rate to the
MATLAB workspace.

4 Make A20 the active cell to transfer the settlement date to the MATLAB
workspace.

5 Execute the functions in cells A23 and A24 to enable the Financial Toolbox
software to compute cash flow amounts and dates.

6 Now execute the functions in cells A27 through A29 to transform the dates
into string form contained in a cell array.

7 Execute the functions in cells A32 through A34 to transfer the data to the
Excel worksheet.



Mapping Time and Bond Cash Flows

'.-"ﬂ = B NEERE )= Copy of ExliSamp [Cornpatibility Mode] - Microsoft Excel = E
= Home Insert Page Layout Farmulas Data Reviews  Wiew Add-Ins @ - = x
M1 - I
A B C D E E G H J K L ] I a P
1 |Cash Flow and Time Mapping for a Portfolio of Bonds | _|
2 Cash Flow Dates
3 |Settlernent Date 2B-Jul-99 Bond1 | 7/26/1999  11/15/1999 7R, A A MR,
4 Bond2 | 7/26/1993  11A15A1%33 5152000 A, A, A&,
i Bond Data Bond3 7i264A1998 114151999 &815/2000 11/15/2000 A A
3 Bondd | 7/26/1993  11/151998 5152000 11/15/2000 5M15/2001 A
7 Maturity Coupon Rate Bond5 7/2BA993 114151999 5A5/2000  11/15/2000 5/15/2001 11A1552001
8 Bond1 15-Mov-59 0.05875

9 Bond2 15-tday-00 0.06375
10 |Bond3 15-Mov-00 (0.08500
11 |Bondd 15-May-01 0.08000

12 Bond5 15-Mov-01 0.15750 Cash Flow Amounts

] 772641982 11A15A1993 5152000 11/15/2000 51572001 11452001
14 Bond1 -1.1495 102.9375 0 0 0 0

15 BondZ -1.2473 3.1875 103.1875 0 il 0

16 | Spreadsheet Link EX Functions Bond3 -1.6630 4.2500 4.2500 104.2500 a 0]

17 |1. Transfer data to MATLAB Bondd -1.5652 4.0000 4.0000 4.0000  104.0000 0

18 0 === MLPutMatrix("maturity" "Maturity’) Bond5 -3.0815 7.8750 7.8750 7.8750 7.B750  107.8750
19 0 === MLPutMatrix("cpnrate” "CpnRate")

20 0 === MLPutMatrix("sd",C3) =|
21

22 2. Execute MATLAB Financial Toolbox Cash flow and Tirne mapping function

2 0 == MLEvalString("md = ¥2mdate(maturity 0); sdm = x2mdate(sd 0)")

24 0 === MLEvalString("[cfa, cfd] = cfamounts(cpnrate, sdm, md, 2)")

%

26 |3. Transform date numbers to string cell array

27 0 <== MLEvalString("i = find(isnan(cfd)); zefd = cfd; zefd(i) = 0; scfd=datestr{zcfd 2).")

28 0 == MLEvalstring("ccfd = numZcelliscfd 2); cofd(i) = {MAAY cofd = reshape(cefd, size(cfd));")

29 0 == MLEvalString{"ccfa = cfa; cofafi) = 0; alldates = ccfd{end, ;")

30

31 |4, Transfer output data to Excel
o

32 MWL Gethlatrix("ccfd”, "i3")

33 i} MLGetMatrix("alldates", "i13")

34 0 === MLGetMatrix("ccfa”, "i14")

)

36 (5. Plot the cash flow diagram

f 0 === MLEvalString("cfplot{cfd, cfa); dtaxis(%'B,5dma0);title('Cash Flow Diagram?); xlabel('Cash Flow Dates’);ylabel{Bonds’;")

35

39

40 i
1] |
47 -

W 4 » b Shestl Sheet2 - Sheet3 - Sheetd . SheetS | Sheets %1 ool I |

Ready [EEEET e o

8 Finally, execute the function in cell A37 to display a plot of the cash flows
for each portfolio item.
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B Figure 1 = E=

File Edit “iew Insert Tools Desktop “Window Help
D& h RAN|(E 0E 80

Cash Flow Diagram

-
| .
| I ! f ! I

1 1 1 1 ]
07126 11415 05715 11415 05115 11415
Cash Flow Dates

9 When you finish the example, close the figure window.

2-26



Function Reference

Link Management (p. 3-2) Work with link management
functions
Data Management (p. 3-3) Work with data management

functions



3 Function Reference

3-2

Link Management

matlabinit
MLAutoStart

MLClose
MLOpen
MLUseCellArray

Initialize Spreadsheet Link EX
software and start MATLAB process

Automatically start MATLAB
process

End MATLAB process
Start MATLAB process

Toggle MLPutMatrix to use MATLAB
cell arrays



Data Management

Data Management

matlabfcn

matlabsub
MLAppendMatrix
MLDeleteMatrix
MLEvalString
MLGetFigure
MLGetMatrix
MLGetVar
MLMissingDataAsNaN
MLPutMatrix

MLPutVar

MLShowMatlabErrors

Evaluate MATLAB command given
Microsoft Excel data

Evaluate MATLAB command given
Microsoft Excel data and designate
output location

Create or append MATLAB matrix
with data from Microsoft Excel
worksheet

Delete MATLAB matrix

Evaluate command in MATLAB
software

Import current MATLAB figure into
Microsoft Excel spreadsheet

Write contents of MATLAB matrix
to Microsoft Excel worksheet

Write contents of MATLAB matrix
in Microsoft Excel VBA variable

Set empty cells to NaN or 0

Create or overwrite MATLAB matrix
with data from Microsoft Excel
worksheet

Create or overwrite MATLAB matrix

with data from Microsoft Excel VBA
variable

Return standard Spreadsheet Link
EX errors or full MATLAB errors
using MLEvalString



3 Function Reference

MLStartDir Specify MATLAB current working
folder after startup

MLUseFullDesktop Specify whether to use full MATLAB
desktop or MATLAB Command
Window
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matlabfcn

Purpose

Syntax

Description

Examples

See Also

Evaluate MATLAB command given Microsoft Excel data

Worksheet: matlabfcn(command, inputs)

command MATLAB command to evaluate. Embed the command
in double quotation marks; for example, "command".

inputs Variable length input argument list passed to a
MATLAB command. The argument list may contain
a range of worksheet cells that contain input data.

Passes the command to the MATLAB workspace for evaluation, given
the function input data. The function returns a single value or string
depending upon the MATLAB output. The result is returned to the
calling worksheet cell. This function is intended for use as an Excel
worksheet function.

1 Add the data in worksheet cells B1 through B10, and then return the
sum to the active worksheet cell:

matlabfcn("sum", B1:B10)

2 Plot the data in worksheet cells B1 through B10, using x as the
marker type:

matlabfcn("plot", B1:B10, "x")

matlabsub



matlabinit

Purpose

Syntax

Description

See Also

Initialize Spreadsheet Link EX software and start MATLAB process

matlabinit

Note To run matlabinit from the Microsoft Excel toolbar, click
Tools > Macro. In the Macro Name/Reference box, enter
matlabinit and click Run. Alternatively, you could include this
function in a macro subroutine. You cannot run matlabinit as a
worksheet cell formula or in a macro function.

Initializes the Spreadsheet Link EX software and starts MATLAB
process. If the Spreadsheet Link EX software has been initialized and
the MATLAB software is running, subsequent invocations do nothing.
Use matlabinit to start Spreadsheet Link EX and MATLAB sessions
manually when you have set MLAutoStart to no. If you set MLAutoStart
to yes, matlabinit executes automatically.

MLAutoStart, MLOpen
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matlabsub

4-4

Purpose

Syntax

Description

Evaluate MATLAB command given Microsoft Excel data and designate

output location

Worksheet:

command

edat

inputs

matlabsub(command, edat, inputs)

MATLAB command to evaluate. Enter the
MATLAB command in double quotation marks,
as "command".

Worksheet location where the function writes

the returned date. "edat" (in quotation marks)
directly specifies the location and it must be a cell
address or a range name. edat (without quotation
marks) is an indirect reference: the function
evaluates the contents of edat to get the location.
edat must be a worksheet cell address or range
name.

Variable length input argument list passed to
MATLAB command. This argument list can
contain a range of worksheet cells that contain
input data.

Passes the specified command to the MATLAB workspace for
evaluation, given the function input data. The function returns a single
value or string depending upon the MATLAB output. This function is
intended for use as an Excel worksheet function.

To return an array of data to theMicrosoft Excel Visual Basic for
Applications (VBA) workspace, see MLEvalString and MLGetVar.

Caution edat must not include the cell that contains the matlabsub
function. In other words, be careful not to overwrite the function itself.
Also make sure there is enough room in the worksheet to write the
matrix contents. If there is insufficient room, the function generates a

fatal error.




matlabsub

Examples Sum the data in worksheet cells B1 through B10, and then return the
output to cell A1l:

matlabsub("sum", "A1", B1:B10)

See Also matlabfcn



MLAppendMatrix

4-6

Purpose

Syntax

Description

Create or append MATLAB matrix with data from Microsoft Excel

worksheet

Worksheet:
Macro:

var_name

mdat

MLAppendMatrix(var_name, mdat)
MLAppendMatrix var_name, mdat

Name of MATLAB matrix to which to append
data. "var_name" (in quotation marks) directly
specifies the matrix name. var_name (without
quotation marks) is an indirect reference: the
function evaluates the contents of var_name to
get the matrix name, and var_name must be a
worksheet cell address or range name

Location of data to append to var_name. mdat
(no quotation marks). Must be a worksheet cell
address or range name.

If this argument is not initially an Excel Range
data type and you call the function from a
worksheet, MLAppendMatrix performs the
necessary type coercion.

If this argument is not an Excel Range data
type and you call the function from within a
Microsoft Visual Basic macro, the call fails. The
error message ByRef Argument Type Mismatch
appears.

Appends data in mdat to MATLAB matrix var_name. Creates var_name

if it does not exist. The function checks the dimensions of var_name and
mdat to determine how to append mdat to var_name. If the dimensions
allow appending mdat as either new rows or new columns, it appends
mdat to var_name as new rows. If the dimensions do not match, the

function returns an error. mdat must contain either numeric data or

string data. Data types cannot be combined within the range specified



MLAppendMatrix

Examples

See Also

in mdat. Empty mdat cells become MATLAB matrix elements containing
zero if the data is numeric, and empty strings if the data is a string.

Example 1: Append data from a worksheet cell range to
a MATLAB matrix

In this example, B is a 2-by-2 MATLAB matrix. Append the data in
worksheet cell range A1:A2 to B:

MLAppendMatrix("B", A1:A2)

Al

A2

B is now a 2-by-3 matrix with the data from A1:A2 in the third column.

Example 2: Append data from a named worksheet cell
range to a MATLAB matrix

B is a 2-by-2 MATLAB matrix. Cell C1 contains the label (string) B,
and new_data is the name of the cell range A1:B2. Append the data in
cell range A1:B2 to B:

MLAppendMatrix(C1, new_data)

B is now a 4-by-2 matrix with the data from A1:B2 in the last two rows.

Al B1
A2 B2
MLPutMatrix



MLAutoStart

Purpose

Syntax

Description

Examples

See Also

Automatically start MATLAB process

Worksheet: MLAutoStart("yes")
MLAutoStart("no")

Macro: MLAutoStart "yes"
MLAutoStart "no"
"yes" Automatically start the Spreadsheet Link EX and

MATLAB software every time a Microsoft Excel
session starts (default).

"no" Cancel automatic startup of the Spreadsheet Link
EX and MATLAB software. If these products are
running, it does not stop them.

Sets automatic startup of the Spreadsheet Link EX and MATLAB
software. When the Spreadsheet Link EX software is installed, the
default is yes. A change of state takes effect the next time an Excel
session starts.

Cancel automatic startup of the Spreadsheet Link EX and MATLAB
software:

MLAutoStart("no")

These products do not start on subsequent Excel session invocations.

matlabinit, MLClose, MLOpen



MLClose

Purpose

Syntax

Description

See Also

End MATLAB process

Worksheet: MLClose()

Macro: MLClose

Ends the MATLAB process, deletes all variables from the MATLAB
workspace, and tells the Microsoft Excel software that the MATLAB
software is no longer running. If no MATLAB process is running,
nothing happens.

MLOpen
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MLDeleteMatrix

4-10

Purpose Delete MATLAB matrix
Syntax Worksheet: MLDeleteMatrix(var_name)
Macro: MLDeleteMatrix var_name
var_name Name of MATLAB matrix to delete. "var_name"

(in quotation marks) directly specifies the matrix
name. var_name (without quotation marks) is

an indirect reference: the function evaluates the
contents of var_name to determine the matrix name,
and var_name must be a worksheet cell address or
range name.

Description Deletes the named matrix from the MATLAB workspace.

Example Delete matrix A from the MATLAB workspace:

MLDeleteMatrix ("A")



MLEvalString

Purpose

Syntax

Description

Examples

See Also

Evaluate command in MATLAB software

Worksheet: MLEvalString(command)
Macro: MLEvalString command
command MATLAB command to evaluate. "command" (in

quotation marks) directly specifies the command.
command (without quotation marks) is an indirect
reference: the function evaluates the contents of
command to get the command, and command must be
a worksheet cell address or range name.

Passes a command string to the MATLAB software for evaluation. The
specified action alters only the MATLAB workspace. It has no effect
on the Microsoft Excel workspace.

Divide the MATLAB variable b by 2, and then plot it:
MLEvalString("b = b/2;plot(b)")

This command only modifies the MATLAB variable b. To update data
in the Excel worksheet, use MLGetMatrix.

MLGetMatrix
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Purpose Import current MATLAB figure into Microsoft Excel spreadsheet
Syntax Worksheet: MLGetFigure(width,height)
Macro: MLGetFigure width, height
width Specify the width in normalized units of the
MATLAB figure when imported into an Excel
worksheet.
height Specify the height in normalized units of the
MATLAB figure when imported into an Excel
worksheet.
Description Import the current MATLAB figure into an Excel worksheet, where the

top-left corner of the figure is the current spreadsheet cell.

If worksheet calculation mode is automatic, MLGetFigure executes
when you enter the formula in a cell. If worksheet calculation mode
is manual, enter the MLGetFigure function in a cell, then press F9 to
execute it. However, pressing F9 in this situation may also reexecute
other worksheet functions and generate unpredictable results.

If you use MLGetFigure in a macro subroutine, enter MatlabRequest
on the line after the MLGetFigure. MatlabRequest initializes internal
Spreadsheet Link EX variables and enables MLGetFigure to function in
a subroutine. Do not include MatlabRequest in a macro function unless
the function is called from a subroutine.

Examples Import the current MATLAB figure into an Excel worksheet. Adjust the

width of the figure to be half that of the original figure, and the height
to be a quarter that of the original figure:

MLGetFigure(.50,.25)

See Also MLGetMatrix, MLGetVar
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Purpose

Syntax

Description

Write contents of MATLAB matrix to Microsoft Excel worksheet

Worksheet:
Macro:

var_name

edat

MLGetMatrix(var_name, edat)
MLGetMatrix var_name, edat

Name of MATLAB matrix to access."var_name" (in
quotation marks) directly specifies the matrix name.
var_name (without quotation marks) is an indirect
reference: the function evaluates the contents of
var_name to get the matrix name, and var_name
must be a worksheet cell address or range name.
var_name cannot be the MATLAB variable ans.

Worksheet location where the function writes the
contents of var_name. "edat" (in quotation marks)
directly specifies the location and it must be a cell
address or a range name. edat (without quotation
marks) is an indirect reference: the function
evaluates the contents of edat to get the location,
and edat must be a worksheet cell address or range
name.

Writes the contents of MATLAB matrix var_name in the Excel
worksheet, beginning in the upper-left cell specified by edat. If

data exists in the specified worksheet cells, it is overwritten. If the
dimensions of the MATLAB matrix are larger than that of the specified
cells, the data overflows into additional rows and columns.

Caution

edat must not include the cell that contains the MLGetMatrix function.

In other words, be careful not to overwrite the function itself. Also make
sure there is enough room in the worksheet to write the matrix contents.
If there is insufficient room, the function generates a fatal error.
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MLGetMatrix function does not automatically adjust cell addresses. If
edat is an explicit cell address, edit it to correct the address when you
do either of the following:

¢ Insert or delete rows or columns.

e Move or copy the function to another cell.

If worksheet calculation mode is automatic, MLGetMatrix executes
when you enter the formula in a cell. If worksheet calculation mode is
manual, enter the MLGetMatrix function in a cell, and then press F9 to

execute it. However, pressing F9 in this situation may also reexecute
other worksheet functions and generate unpredictable results.

If you use MLGetMatrix in a macro subroutine, enter MatlabRequest
on the line after the MLGetMatrix. MatlabRequest initializes internal
Spreadsheet Link EX variables and enables MLGetMatrix to function in
a subroutine. Do not include MatlabRequest in a macro function unless
the function is called from a subroutine.

Examples Example 1

Write the contents of the MATLAB matrix bonds starting in cell C10 of
Sheet2. If bonds is a 4-by-3 matrix, fill cells C10. .E13 with data:

MLGetMatrix("bonds", "Sheet2!C10")

Example 2

Access the MATLAB matrix named by the string in worksheet cell
B12. Write the contents of the matrix to the worksheet starting at the
location named by the string in worksheet cell B13:

MLGetMatrix (B12, B13)

Example 3

Write the contents of MATLAB matrix A to the worksheet, starting at
the cell named by RangeA:
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See Also

Sub Get_RangeA()
MLGetMatrix "A", "RangeA"
MatlabRequest

End Sub

Example 4
In a macro, use the Address property of the range object returned by
the VBA Cells function to specify where to write the data:

Sub Get_Variable()

MLGetMatrix "X", Cells(3, 2).Address
MatlabRequest

End Sub

MLAppendMatrix, MLPutMatrix
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Purpose

Syntax

Description

Examples

See Also

Write contents of MATLAB matrix in Microsoft Excel VBA variable

MLGetVar ML_var_name, VBA_var_name

ML_var_name

VBA_var_name

Name of MATLAB matrix to access.
"ML_var_name" (in quotation marks) directly
specifies the matrix name. ML_var_name
(without quotation marks) is an indirect
reference: the function evaluates the contents
of ML_var_name to get the matrix name,

and ML_var_name must be a VBA variable
containing the matrix name as a string.
var_name cannot be the MATLAB variable
ans. If defined, ML_var_name should be of type
VARIANT. Any other type will give a "TYPE
MISMATCH" error.

Name of VBA variable where the function
writes the contents of ML_var_name. Use
VBA_var_name without quotation marks.

Writes the contents of MATLAB matrix ML_var_name in the
Excel Visual Basic for Applications (VBA) variable VBA_var_name.
Creates VBA_var_name if it does not exist. Replaces existing data in

VBA_var_name.

Write the contents of the MATLAB matrix J into the VBA variable

Datad:

Sub Fetch()

MLGetVar "J", Datad

End Sub

MLPutVar



MLMissingDataAsNaN

Purpose

Syntax

Description

Examples

See Also

Set empty cells to NaN or 0

Worksheet: MLMissingDataAsNaN("yes")
MLMissingDataAsNaN("no") (Default)
Macro: MLMissingDataAsNaN "yes"
MLMissingDataAsNaN "no" (Default)
"yes" Sets empty cells to use NaNs.

"no" Sets empty cells to use 0s. (Default)

Sets empty cells to NaN or 0. When the Spreadsheet Link EX software is
installed, the default is "no", so empty cells are handled as 0s. If you
change the value of MLUseCellArray to "yes", the change remains in
effect the next time a Microsoft Excel session starts.

Note A string in an Excel range always forces cell array output and
empty cells as NaNs.

Cancel the use of NaNs for empty cells:

MLMissingDataAsNaN('no")

MLPutMatrix
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Purpose

Syntax

Description

Examples

See Also

Start MATLAB process

Worksheet: MLOpen ()

Macro: MLOpen

Starts MATLAB process. If a MATLAB process has already started,
subsequent calls to MLOpen do nothing. Use MLOpen to restart the
MATLAB session after you have stopped it with MLClose in a given
Microsoft Excel session.

Note We recommend using matlabinit rather than MLOpen, since
matlabinit starts a MATLAB session and initializes the Spreadsheet
Link EX software.

Starts a MATLAB session:

MLOpen ()

matlabinit, MLClose
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Purpose

Syntax

Description

Create or overwrite MATLAB matrix with data from Microsoft Excel
worksheet

Worksheet: MLPutMatrix(var_name, mdat)
Macro: MLPutMatrix var_name, mdat

var_name Name of MATLAB matrix to create or overwrite.
"var_name" (in quotation marks) directly specifies the
matrix name. var_name (without quotation marks)
is an indirect reference: the function evaluates the
contents of var_name to get the matrix name, and
var_name must be a worksheet cell address or range
name.

mdat Location of data to copy into var_name. mdat (no
quotation marks). Must be a worksheet cell address
or range name.

Creates or overwrites matrix var_name in MATLAB workspace with
specified data in mdat. Creates var_name if it does not exist. If var_name
exists, this function replaces the contents with mdat. Empty numeric
data cells within the range of mdat become numeric zeros within the
MATLAB matrix identified by var_name.

If any element of mdat contains string data, mdat is exported as a
MATLAB cell array. Empty string elements within the range of mdat
become NaNs within the MATLAB cell array.

When using MLPutMatrix in a subroutine, indicate the source of the
worksheet data using the Microsoft Excel macro Range. For example:

Sub test()
MLPutMatrix "a", Range("A1:A3")
End Sub

If you have a named range in your worksheet, you can specify the name
instead of the range; for example:
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Sub test()
MLPutMatrix "a", Range("temp")
End Sub

where temp is a named range in your worksheet.

Examples Example 1 — Create or overwrite a matrix in the MATLAB
workspace

Create or overwrite matrix A in the MATLAB workspace with the data
in the worksheet range A1:C3:

MLPutMatrix "A", Range("A1:C3")

Example 2 — Use the putmatrix toolbar button to import
data from a Microsoft Excel worksheet to the MATLAB
workspace

Use the putmatrix toolbar button to import data from an Excel
worksheet to the MATLAB workspace:

1 In the Excel worksheet, select the columns and/or rows you want to
export to the MATLAB workspace.
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2 Click the putmatrix button on the Spreadsheet Link EX toolbar.
A window appears that prompts you to specify the name of the
MATLAB variable in which you want to store your data.

Microsoft Excel @

Yariable name in MATLAR
Cancel

I

3 Enter newmatrix for the MATLAB variable name.

4 Click OK.

Now you can manipulate newmatrix in the MATLAB Command
Window.
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newmatrix
newmatrix =
1 2 3
4 5 6
See Also MLAppendMatrix, MLGetMatrix
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Purpose

Syntax

Description

Examples

Create or overwrite MATLAB matrix with data from Microsoft Excel
VBA variable

MLPutVar ML_var_name, VBA_var_name

ML_var_name Name of MATLAB matrix to create or overwrite.
"ML_var_name" (in quotation marks) directly
specifies the matrix name. ML_var_name (without
quotation marks) is an indirect reference: the
function evaluates the contents of ML_var_name
to get the matrix name, and ML_var_name must
be a VBA variable containing the matrix name
as a string.

VBA var_name Name of VBA variable whose contents are written
to ML_var_name. Use VBA var_name without
quotation marks.

Creates or overwrites matrix ML_var_name in MATLAB workspace with
data in VBA_var_name. Creates ML_var_name if it does not exist. If
ML_var_name exists, this function replaces the contents with data from
VBA_var_name. Use MLPutVar only in a macro subroutine, not in a
macro function or in a subroutine called by a function.

Empty numeric data cells within VBA_var_name become numeric zeros
within the MATLAB matrix identified by ML_var_name.

If any element of VBA var_name contains string data, VBA_var_name
is exported as a MATLAB cell array. Empty string elements within
VBA_var_name become NaNs within the MATLAB cell array.

Create (or overwrite) the MATLAB matrix K with the data in the Excel
Visual Basic for Applications (VBA) variable DataKk.

Sub Put()
MLPutVar "K", DataK
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End Sub

See Also MLGetVar
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MLShowMatlabErrors

Purpose

Syntax

Description

Examples

See Also

Return standard Spreadsheet Link EX errors or full MATLAB errors

using MLEvalString

Worksheet: MLShowMatlabErrors("yes")

MLShowMatlabErrors("no") (Default)

Macro: MLShowMatlabErrors "yes"

MLShowMatlabErrors "no" (Default)

"yes" Displays the full MATLAB error string upon

MLEvalString failure.

"no" Displays the standard Spreadsheet Link EX errors

upon MLEvalString failure.

Sets the Spreadsheet Link EX error display mode when executing

MATLAB commands using MLEvalString.

e Cause MLEvalString failures to show standard Spreadsheet Link EX

errors, such as #COMMAND.

MLShowMatlabErrors("no")

¢ Cause MLEvalString failures to show MATLAB error strings, such

as ?7?? Undefined function or variable

MLShowMatlabErrors("yes")

MLEvalString

'foo'.
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Purpose Specify MATLAB current working folder after startup
Syntax Worksheet: MLStartDir(path)
Macro: MLStartDir path
path Specify the current MATLAB working folder after
startup.
Description Sets the MATLAB working folder after startup. This function does not

work like the standard Microsoft Windows Start In setting, because it
does not automatically run startup.m or matlabrc.min the specified
folder.

Note The working folder changes only if you run MATLAB after you
run this function. Running this function while MATLAB is running
does not change the working folder for the current session. In this
case, MATLAB uses the specified folder as the working folder when
it is restarted.

Examples Set the MATLAB working folder to d: \work after startup:
MLStartDir ( d:\work )

If your folder path includes a space, embed the path in single quotation
marks within double quotation marks. For example, to set the MATLAB
working folder to d:\my work, run the command:

MLStartDir ( 'd:\my work' )

See Also MLAutoStart
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Purpose

Syntax

Description

Examples

See Also

Toggle MLPutMatrix to use MATLAB cell arrays

Worksheet: MLUseCellArray("yes")
MLUseCellArray ("no")

Macro: MLUseCellArray "yes"
MLUseCellArray "no"

"yes" Automatically uses cell arrays for transfer of data
structures.
"no" Do not automatically use cell arrays for transfer of

data (default).

Using MLUseCellArray forces MLPutMatrix to use cell arrays for
transfer of data (for example, dates). When the Spreadsheet Link EX
software is installed, the default is "no". If you change the value of
MLUseCellArray to "yes", the change remains in effect the next time
a Microsoft Excel session starts.

Cancel automatic use of cell arrays for easy transfer of data:

MLUseCellArray("no")

MLPutMatrix
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Purpose

Syntax

Description

Examples

See Also

Specify whether to use full MATLAB desktop or MATLAB Command
Window

Worksheet: MLUseFullDesktop("yes")
MLUseFullDesktop("no")

Macro: MLUseFullDesktop "yes"
MLUseFullDesktop "no"

"yes" Start full MATLAB desktop.
"no" Start the MATLAB Command Window only.

Sets the MATLAB session to start with the full desktop or Command
Window only. When the Spreadsheet Link EX software is installed,
the default is "yes".

Start only the MATLAB Command Window:

MLUseFullDesktop("no")

matlabinit, MLClose, MLOpen



Error Messages and
Troubleshooting

This appendix covers the following topics:

* “Worksheet Cell Errors” on page A-2

® “Microsoft® Excel Software Errors” on page A-5
e “Data Errors” on page A-8

e “Startup Errors” on page A-10

® “Audible Error Signals” on page A-11
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Worksheet Cell Errors

You may see these error messages displayed in a worksheet cell.
The first column of the following table contains worksheet cell error messages.
The error messages begin with the number sign (#). Most end with an

exclamation point (!) or with a question mark (?).

Worksheet Cell Error Messages

Worksheet Cell

Error Message Meaning Solution

#COLS>#MAXCOLS! Your MATLAB variable exceeds | This is a limitation in the Excel
the Microsoft Excel limit of product. Try the computation
#MAXCOLS! columns. with a variable containing fewer

columns.

#COMMAND ! The MATLAB software does not | Verify the spelling of the MATLAB
recognize the command in an command. Correct typing errors.
MLEvalString function. The
command may be misspelled.

#DIMENSION! You used MLAppendMatrix and Verify the matrix dimensions and
the dimensions of the appended | the appended data dimensions,
data do not match the dimensions | and correct the argument.
of the matrix you want to append. | For more information, see the

MLAppendMatrix reference page.

#INVALIDNAME! You entered an illegal variable Make sure to use legal MATLAB

name. variable names. MATLAB
variable names must start with a
letter followed by up to 30 letters,
digits, or underscores.

#INVALIDTYPE! You have specified an illegal For a list of supported MATLAB
MATLAB data type with data types, see “Classes (Data
MLGetVar or MLGetMatrix. Types)” in the MATLAB

Programming Fundamentals
documentation.
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Worksheet Cell Error Messages (Continued)

Worksheet Cell

Error Message Meaning Solution

#MATLAB? You used a Spreadsheet Link Start the Spreadsheet Link EX
EX function and no MATLAB and MATLAB software. See
software session is running. “Starting and Stopping the

Spreadsheet Link EX Software”
on page 1-13.

#NAME? The function name is Be sure the excllink.xla add-in
unrecognized. The excllink.xla | is loaded. See “Configuring the
add-in is not loaded, or the Spreadsheet Link EX Software”
function name may be misspelled. | on page 1-5. Check the spelling of

the function name. Correct typing
errors.

#NONEXIST! You referenced a nonexistent Verify the spelling of the MATLAB
matrix in an MLGetMatrix or matrix. Use the MATLAB whos
MLDeleteMatrix function. The command to display existing
matrix name may be misspelled. | matrices. Correct typing errors.

#ROWS>#MAXROWS ! Your MATLAB variable exceeds | This is a limitation in the Excel
the Excel limit of #MAXROWS!! product. Try the computation
TrOWS. with a variable containing fewer

rOwsS.

#SYNTAX? You entered a Spreadsheet Verify and correct the function

Link EX function with incorrect
syntax. For example, you did not
specify double quotation marks
(") , or you specified single
quotation marks () instead of
double quotation marks.

syntax. For more information,
see Chapter 4, “Functions —
Alphabetical List”.
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Worksheet Cell Error Messages (Continued)

Worksheet Cell

Error Message Meaning Solution

#VALUE ! An argument is missing from a Supply the correct number of
function, or a function argument | function arguments, of the correct
1is the wrong type. type.

#VALUE! A macro subroutine uses Since the function works correctly,

MLGetMatrix followed by
MatlabRequest, which is correct
standard usage. A macro function

ignore the message. Or, in
this special case, remove
MatlabRequest from the

calls that subroutine, and you subroutine.
execute that function from a
worksheet cell. The function
works correctly, but this message

appears in the cell.

Note When you open an Excel worksheet that contains Spreadsheet Link EX
functions, the Excel software tries to execute the functions from the bottom up
and right to left. Excel may generate cell error messages such as #COMMAND !
or #NONEXIST!. This is expected behavior. Do the following:

1 Ignore the messages.
2 Close MATLAB figure windows.

3 Reexecute the cell functions one at a time in the correct order by pressing
F2, and then Enter.




Microsoft® Excel® Software Errors

Microsoft Excel Software Errors

The Excel software may display one of the following error messages.

Excel Error Messages

Error Message

Cause of Error

Solution

Error in formula

You entered a formula
incorrectly. Common errors
include a space between the
function name and the left
parenthesis; or missing, extra,
or mismatched parentheses.

Check entry and correct typing
errors.

Can't find project or
library

You tried to execute a
macro and the location of
excllink.xla is incorrect.

Click OK. The References
window opens. Remove

the check from MISSING:
excllink.xla. Find
excllink.xla in its correct
location, select its check box in

the References window, and
click OK.

Run-time error '1004':
Cells method of

Application class failed

You used MLGetMatrix and the
matrix is larger than the space
available in the worksheet.
This error destabilizes the
Spreadsheet Link EX software
session and changes worksheet
calculation mode to manual.

Click OK. Reset worksheet
calculation mode to
automatic, and save your
worksheet as needed. Restart
the Excel, Spreadsheet Link
EX, and MATLAB software
sessions.
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Excel Error Messages (Continued)

Error Message

Cause of Error

Solution

Spreadsheet Link EX
license checkout failed!

The license passcode that you
entered was invalid.

Check that you entered the
license passcode properly. If
you used a proper passcode
and you are still unable to
start the Spreadsheet Link
EX software, contact your
MathWorks representative.

Datasource: Excel;
prompt for user name
and password

This message appears when an
attempt to connect to the Excel
software from the Database
Toolbox™ software fails.

Make sure that the Excel
spreadsheet referenced by the
data source exists, then retry
the connection.
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Excel Error Message Boxes

Error Message Box

Cause of Error

Solution

Micrasaft Wisual Basic

Run-time error '-2147024694 (80070002)':

Automation error
The system cannat find the file specified.

‘ End Help ‘

This error appears
when you start
the automation
server from the
Excel interface,
and multiple
versions of the
MATLAB software
are installed on
your desktop.

To correct this error, perform the
following:

1 Shut down all MATLAB and Excel
instances.

2 Open a Command Prompt window,
and using cd, change to the bin\win32
subdirectory of the MATLAB
installation folder.

3 Type the command:

.\matlab /regserver

4 When the MATLAB software session
starts, close it. Using /regserver fixes
the registry entries.

5 Start an Excel software session. The
Spreadsheet Link EX add-in now loads

properly.

6 Verify that the Spreadsheet Link EX
software 1s working by entering the
following command from the MATLAB
Command Window:

a = 3.14159

7 Enter the following formula in cell A1 of
the open Excel worksheet:
=mlgetmatrix("a","atl")

8 The value 3.14159 appears in cell A1.
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Data Errors

In this section...

“Matrix Data Errors” on page A-8

“Errors When Opening Saved Worksheets” on page A-8

Matrix Data Errors

Data in the MATLAB or Microsoft Excel workspaces may produce the
following errors.

Data Errors

Data Error

Cause

Solution

MATLAB matrix cells
contain zeros (0).

Corresponding Excel worksheet
cells are empty.

Excel worksheet cells must
contain only numeric or string
data.

MATLAB matrix is a
1-by-1 zero matrix.

You used quotation marks
around the data-location
argument in MLPutMatrix or
MLAppendMatrix.

Correct the syntax to remove
quotation marks.

MATLAB matrix is
empty ([ 1).

You referenced a nonexistent
VBA variable in MLPutVar.

Correct the macro; you may
have typed the variable name
incorrectly.

VBA matrix is empty.

You referenced a nonexistent
MATLAB variable in MLGetVar.

Correct the macro; you may
have typed the variable name
incorrectly.

Errors When Opening Saved Worksheets

This section describes errors that you may encounter when opening saved
worksheets.

® When you open an Excel worksheet that contains Spreadsheet Link EX
functions, the Excel software tries to execute the functions from the bottom
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up and right to left. Excel may generate cell error messages such as
#COMMAND ! or #NONEXIST!. This is expected behavior. Do the following:

1 Ignore the messages.
2 Close MATLAB figure windows.

3 Reexecute the cell functions one at a time in the correct order by pressing
F2, and then Enter.

If you save an Excel worksheet containing Spreadsheet Link EX functions,
and then reopen it in an environment where the excllink.xla add-in is in
a different location, you may see the message: This document contains
links: Re-establish links?

To address this issue, do the following:

1 Click No.

2 Select Edit > Links.

3 In the Links dialog box, click Change Source.

4 In the Change Links dialog box, and select
matlabroot\toolbox\exlink\excllink.xla.

5 Click OK.

The Excel software executes each function as it changes its link. You
may see MATLAB figure windows and hear error beeps as the links
change and functions execute; ignore them.

6 In the Links dialog box, click OK.

The worksheet now connects to the Spreadsheet Link EX add-in.

Or, instead of using the Links menu, you can manually edit the link
location in each affected worksheet cell to show the correct location of
excllink.xla.
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Startup Errors

If you have enabled MLAutoStart, double-clicking an x1s file in the MATLAB
Current folder browser and choosing Open Outside MATLAB causes a
Microsoft Excel error to appear. To open the file successfully, click End in
the error window.

To avoid this issue, disable MLAutoStart. Start MATLAB software sessions

from the Excel interface by clicking the startmatlab button in the Excel
menu bar.
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Audible Error Signals

You may hear audible errors while passing data to the MATLAB workspace
using MLPutMatrix or MLAppendMatrix. These errors usually indicate that
you have insufficient computer memory to carry out the operation. Close other
applications or clear unnecessary variables from the MATLAB workspace and
try again. If the error signal reoccurs, you probably have insufficient physical
memory in your computer for this operation.
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Examples

Use this list to find examples in the documentation.
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Macro Examples

“Sending MATLAB Data to an Excel Worksheet and Displaying the
Results” on page 1-24

“Importing and Exporting Data between the Microsoft® Excel Interface and
the MATLAB Workspace” on page 1-26

Financial Examples

“Modeling Data Sets Using Data Regression and Curve Fitting” on page 2-3
“Interpolating Data” on page 2-11

“Pricing Stock Options Using the Binomial Model” on page 2-15
“Calculating and Plotting the Efficient Frontier of Financial Portfolios”

on page 2-19

“Mapping Time and Bond Cash Flows” on page 2-23
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